Act! Quick Start for New Users

Act! helps organize all your prospect and customer details in one place so you can prioritize your day and
market your products and services more effectively.
This Quick Start for New Users Guide explains some of the basics of getting started with Act!. If you are
viewing the Quick Start guide online, click the link to go to the page.
Get to Know the Workspace
All About Databases
Import Contacts
Add Contacts to the Database
Set Preferences for Email
Track Your Schedule and Manage Appointments
Communicate with Your Contacts
Organize Your Contacts into Groups
Keep More Details about Your Contacts
Search for Contacts
Share Information with Others
TIP: The Quick Reference Card also provides shortcuts and quick tips. Go to Help>Online Manuals.
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Get to Know the Workspace
Most of the tasks that you want to do in Act! require you to:
l

Open a View.

l

Click commands on the Menu bar.

l

Click buttons (tools) on the Global toolbar.

l

Click items on the Navigation bar (Navbar).

l

Click tools on a view toolbar.

The following section describes these items.
View. Appears in the main window of the application. The views are: Act! Insight, Act! Connect, Contacts, Groups,
Companies, Calendar, Task List, History List, Opportunities, Emarketing, Reports, Dashboard, Search, and
Welcome Page. The Contacts, Groups, Companies, and Opportunities views have a Detail view and List view that
you can toggle between.
Menu bar. Located at the top of all views. It contains the default menus and commands for the current view. This
means, if you change to a different view, some of the menu commands change to match the view.
Global toolbar. Located at the top of all views. It has buttons (tools) for the most frequently used tasks in every
view. An arrow on a button indicates a list of options to select from.
Navigation bar (Navbar). Appears on the left of any view. It contains the primary navigation items for opening
views and a Lookup feature for finding information.
View toolbar. Located at the top of every view. It displays tools for tasks related to the view.
TIP: For more information about the workspace, see Help. To open Help, press F1 within Act! or on the global
toolbar, click Help Topics.
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All About Databases
After you install Act!, you need to create a database to store information about the people you want to track. The
first time you open the application, you are prompted to create a database or open an existing database. If you are
a single user or an Administrator of a workgroup, you would select to create an Act! database.
Create a database
1. On the Welcome! screen, select Create an Act! database. Click OK.
(NOTE: If you are a member of a workgroup sharing a database, then in most cases, your Administrator
would create the database first. You would then select to open an existing database.)
2. In the Database name field, type a name for the new database. The name must begin with a letter. Do not
include spaces or punctuation.
3. In the Location field it will display the default locationwhere the database will be created. You can browse
to another local location to save your database.
4. From the Currency list, select a currency for the database.
5. To share the database with others, select the Share this database with other users check box.
6. In the User name field, type the name of the person who will be logging on to the database.
IMPORTANT: This step creates a contact record known as "My Record." In most cases, this will be your
name.
7. To set a logon password for the user, in the Password field, type a password. Type it again to confirm.
8. Click OK.
To see an example of a customized database, you can open the demonstration database that is installed with the
software. You can view the sample contacts, groups, activities, and other data included in the database. See
"Opening the Demo Database" in Help.
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Import Contacts
Once you have opened a database, the next step is to add your information. You may have been using other
applications to track information. For example, you may use Microsoft® Excel® or Outlook® to track your contacts,
clients, or customers. You might purchase prospect lists online. You can bring this information into Act! without
manually entering it. You can import your contact information using the Import Wizard, or set up contact
integration/synchronization with Outlook or Google.
The following section describes how to import contacts from an Excel list using the Import Wizard.
Import contacts from an Excel list
1. Open a database.
2. On the File menu, click Import.
TIP: If the Import command from the File menu is not available (appears dimmed), this means you are not
set up with the Administrator role. See "What are User Roles and Permissions" in Help for how to set up
user roles.
3. On the Welcome page, click Next.
4. On the Specify source page:
a. From the What type of file do you want to import? list, select Excel.
Note: Excel must be installed on your computer for it to appear in the source selection list. If it is not
installed, you need to change the Excel file's format from .xls to a Text separated by commas (.CSV) or
Text separated by tabs (.TXT) format and select one of those types as the source.
b. In the File name and location field, enter the file name and path of the Excel source file, or click
Browse to locate the file. If necessary, click Open.
c. If necessary, complete other fields.
d. Click Next.
5. On the Specify record types page, keep the default option of Contact records selected, and click Next.
6. On the Import Type page, keep the default option of Typical import selected, and click Next.
7. On the Confirm Import page, if the information is correct, click Import. If the information is not correct,
click Back until you reach the page that needs correction.
The Import Wizard processes the imported data.
8. On the Import Complete page, a message appears. To view the details of imported data and any errors,
click View import log. To close the import wizard, click Finish.
9. To see the imported data, on the Navbar, click Contacts. Then, on the view toolbar, click List view. The
Contact List view opens to display the imported data.
See Help for information on contact integration/synchronization and importing.
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Add Contacts to the Database
In addition to importing contacts, you can manually add contacts to the database.
Add a contact
1. On the global toolbar, click the arrow next to New, and then click Contact.
A blank contact record appears. This is known as the Contact Detail view. You use the Contact Detail
view to enter information about one contact. See "Learning About Contact Views" in Help for more
information.
2. Type information in the fields, or if a field has a drop-down arrow, select data from a list. Enter as much or
as little information as you need.
l

l

l

If an exclamation point appears, you need to change the entry in the field. Pause the pointer over the
exclamation point for more information.
If you plan to set up integration with other applications, such as Outlook or Google, be sure to enter
email addresses for the contact. By default, three email address fields are available.
Use the ID/Status field to identify contacts by categories. For example, you might have categories such
as Personal, Vendor, or Competitor. TIP: This is helpful because you will be able to do a lookup and
create a list of contacts by category (using the ID/Status field).

3. To correctly identify the first, middle, and last names, click the browse button (...) in the Contact field.*
This ensures that the contact's first and last names and title are used correctly in correspondence. To
identify how the salutation should appear in correspondence, you can set a preference. For more
information, see "Customizing Name Prefixes and Suffixes" in Help.
4. Add more information about the contact using the tabs located at the bottom of the Contact Detail view.
Click a tab to see the types of details you can enter. This guide explains the Notes, History, and
Documents tab in "Keep More Details About Your Contacts" on page 9.
*(If the contact's name is simply First Last, you can skip this step.)
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Set Preferences for Email
You can set preferences to make Act! work the way you want. Some of the preferences you can set include:
l

Setting up an email system to use with Act!.

l

Selecting either the Act! Word Processor or Microsoft Word to use when writing letters.

l

Changing the colors and fonts of the views and tabs.

l

Selecting a view that opens when you start Act!.

Some default preferences are already set for you. However, you need to set up email to write and send messages.
If you currently use Outlook as your email program, you can use it with Act!.
For more information about compatible email systems and steps for setting other preferences, see "Setting E-mail
Preferences" in Help.
Set up email to use Microsoft Outlook
1. On the global toolbar, click the arrow next to E-mail, and then click E-mail Preferences.
2. Click the E-mail System Setup button.
3. The E-mail Setup Wizard appears. Click Next.
4. On the E-mail page, select Microsoft Outlook. Click Next.
5. On the E-mail Outlook Address Books page, to select an Act! database to use as an address book in
Outlook, click Add.
a. In the Add/Edit Address Book dialog box, if you have only one database, its name (and .PAD file
pointer) appears in the Act! Database field, by default.
b. The logged-in user's name should appear in the User name field. If it does not, type it.
c. If a password is required for the selected database, type it in the Password field.
d. Click OK.
On the remaining pages of the E-mail Wizard, Act! has already set options for the best way to use
Outlook. You can keep the default settings on each page and just click Next to proceed through setup, or
you can change the default settings. The following steps keep the default settings. For more information
about the setup options available on these pages, see Help.
6. On the E-mail Editor page, in the Select an e-mail editor field, Microsoft Outlook is selected. This means
you will use Outlook to manage, view, and send e-mail with Act!, and you will use your Outlook signature.
Click Next.
7. On the E-mail - Record History of Sent Emails page, keep the default settings. Click Next.
8. On the E-mail - Record History of Received Emails page (Act! v21 onwards), keep the default settings.
Click Next.
9. On the E-mail Attach to Act! Contacts page, keep the default settings. Click Next.
10. On the E-mail - Activity Invitation page, keep the default settings. Click Next.
11. Click Finish.
You are ready to send email to a contact.
TIP: You can also synchronize your Outlook contacts and calendar with Act!. (This means that you can share
contact and calendar information between Outlook and Act! and keep it up to date in both applications.) See
Help for steps to set up Outlook sync.
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Track Your Schedule and Manage Appointments
In Act!, to-do items and scheduled appointments, such as telephone calls or meetings, are called Activities.
Scheduled activities appear on your calendar, in the Task List, on the Activities tab, and in the Dashboard. The
global toolbar has buttons for the default activity types of Call, Meeting, and To-Do. You can also create custom
activity types. See Help for more information.
When you complete an activity, you need to clear it from your schedule. You can add a history of the activity to the
contact's record. (Histories are explained in "Keep More Details About Your Contacts" on page 9.)
EXAMPLE: You need to schedule a meeting with a prospect and several of the key decision makers at his
company to demonstrate your products. While scheduling the meeting, you can send an iCalendar invitation to the
attendees. When you return from the meeting, you need to clear the activity from your schedule and record an
outcome of the discussion.
Schedule an activity
1. On the global toolbar, click the Call, Meeting, or To-do button for the type of activity you want to schedule.
or
To schedule another type of activity, click the arrow next to New, point to Other Activity. Select an
activity from the list.
2. Complete the fields in each tab of the Schedule Activity dialog box to select the attendees, send an
iCalendar invitation email, provide details, attach a document, and more. (For more information about the
fields and tabs, see "Scheduling Activities" in Help.)
3. Click OK.
4. If you are notified of a scheduling conflict, resolve it.
TIP: You can set up calendar integration with Outlook or Google. For more information, see Help.
Clear an activity from the Task List
1. On the Navbar, click Task List.
2. Click the check mark column box in the Cleared column for the activity.
The Clear Activity dialog box appears.
3. Select a Results option for the outcome of the activity.
4. To include details with the history of the activity, make sure the Add Details to History option is selected.
In the text box, edit activity details as needed.
5. Click OK.
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Communicate with Your Contacts
Act! provides many ways for you to communicate with your contacts. Templates are provided for email messages,
letters, memos, newsletters, and more. You can write a letter or send an email to one contact, or use mail merge to
write a letter or send an email to a group of contacts. (Groups are explained in "Organize Your Contacts Into
Groups" on the next page.)
You must have set up email and selected a word processor (in Preferences). For information about setting up
faxing, the Dialer, and mail merge, see Help.
The following explains how to write and send an e-mail message to a contact.
Write and send an e-mail message
1. On the global toolbar, click the arrow next to E-mail, and then click Write E-mail. (TIP: You can also click
the contact's e-mail address.)
The message window appears with the recipient's name in the To field.
2. To send a copy of the e-mail to other recipients, do the following:
a. Click To or Cc.
b. From the dialog box that appears, select names from the list on the left. Click To or Cc to add the
names to the list on the right.
c. Click OK.
3. In the Subject field, type a short description of the message.
4. Select options: Priority, Create History, Make history private, or Return receipt.
5. In the text box, type your message.
6. To format the text, click the Format menu. Select HTML, and then format text. (You cannot format Plain
Text. You can set a preference to specify a default text format.)
7. To insert a signature, click the Insert Signature tool.
8. Click Send.
Write a letter for one contact
1. Display the contact's Detail view or select a contact on the Contact List.
2. On the Write menu, click Letter.
The document template opens in your selected word processor. The contact's information, such as name
and address, appears in the template.
3. Type the body of the document. (TIP: Use the word processor's tools to change the document's text or
formatting.)
4. Click Save.
5. Use the word processor's menus to print, fax, or email the document.
TIP: You can print labels and envelopes for contacts using a report template. For more information, see Help.
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Organize Your Contacts into Groups
You can organize contacts into groups. Groups let you work with several contacts at once, such as when you send
emails or organize meetings.
You can create a group of static contacts which means the contacts remain in the group until you remove them.
You can also create a group of dynamic contacts using query criteria. With a query, a contact stays in the group as
long as it meets the criteria of the query. A group can include both static and dynamic contacts.
STATIC GROUP EXAMPLE: Create a group of your golf buddies or the parents of your son's carpool.
DYNAMIC GROUP EXAMPLE: Create a group of contacts who are prospects. You name the group: Prospects
Sent ABC Product Brochure. You prepare a new product brochure and send it to every contact in that group. Once
a contact in the group purchases from you, and you enter the information into Act!, the history is updated and that
contact is automatically removed from the group.
Add dynamic contacts to a new group
1. On the global toolbar, click the arrow next to New, and then click Group.
A blank Group Detail view appears.
2. In the Group Name field, type a name for the group. For example, type Prospects Sent ABC Product
Brochure.
3. (Optional) In the Description field, type a short explanation to help you identify the group.
4. At the bottom of the view, the Contacts tab should be displayed. Click the Add/Remove Contacts button.
5. Under Dynamic members, click the Edit Criteria button.
6. In the Group Criteria dialog box, select criteria to build the query:
a. In the Type field, keep the selection of Contact.
b. In the Field Name field, click the down arrow, then select a field from the list. For this example, select
ID/Status.
c. In the Operator field, click the down arrow, then select an item from the list. For this example, select
Equal To (=).
d. In the Value field, click the down arrow, then select an item from the list or type a value. For this
example, select Prospect.
e. Click the Add to list button.
The query criteria you just selected appears in the center pane.
f. To see the contacts who currently meet the criteria and will be added to the group, click the Preview
button.
g. Click OK to add the contacts as members of the group.
In the Add/Remove Contacts dialog box, the query criteria appears in the Dynamic members section.
7. Click OK to save the group and close the dialog box.
In this example, if a contact purchases from you and becomes a customer, you would change their
ID/Status from Prospect to Customer. The contact is automatically removed from the Prospects Sent ABC
Product Brochure group.
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Keep More Details about Your Contacts
You can easily keep additional details about your contacts using the Notes, History, and Documents tabs. These
tabs appear at the bottom of the Contact Detail View (explained in "Add Contacts To The Database" on page 4.)
These tabs are another way of organizing information about a contact.
EXAMPLE: After a meeting ends, you add some notes about action items while they are fresh in your mind. Later
in the day while out of the office, you receive and respond to a call from another contact. You add a history of the
call to the contact's record. You also received a quote from another contact, so you can attach it to the contact's
Documents tab.
Add a note
1. On the global toolbar, click Note.
2. If you had a contact's Detail view open, that contact's name appears in the Contact field. Keep the name,
or select one from the list. Important: You must select at least one contact.
3. The current date and time appears in the Date and Time fields. Keep it, or select from the lists to correct.
4. In the large text box below the formatting buttons, type the note.
5. Click OK.
Add a history
1. On the global toolbar, click History.
2. In the Type field, select the type of history, such as Call.
3. (Optional) In the Result field, select or type the outcome of the action, such as Call Received.
4. In the Contact field, by default, the current contact's name appears. To change it, select a name from the
list. Important: You must select at least one contact.
5. In the Date, Time, and Duration fields, keep the default entries or select from the lists.
6. In the Regarding field, select an item from the list. For example, select Cold Call. TIP: You can type your
own text here.
7. In the Details text box below the formatting buttons, type the history details. For example, enter the cold
call discussion.
8. Click OK.
Add a document for a contact
1. On a Detail View for a contact, click the Documents tab.
2. Click Add, and then select File, Shortcut to File, Shortcut to Folder, or Link (URL). (TIP: File saves the
actual document to the database's supplemental datastore and allows it to be backed up with the
database. Shortcut just saves the shortcut link to the document or folder location.
3. Do one of the following:
l

For a file or shortcut, browse to locate the item to attach, and then click Open.

l

For a link, type the name and address of the URL, and then click OK.

You can also drag and drop a file into the Documents tab. Using Windows® Explorer, locate the file. Then, drag the file onto the
contact's Documents tab. Users might need to disable UAC to allow drag and drop.
You can highlight an attached document and use the Save option to save a copy of the attached file locally.
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Search for Contacts
There are many ways to search for contacts or other information. Several of the methods let you create lists and
work with the results of the search. For more information, see "Features of Act! Search" in Help.
EXAMPLE 1: You remember entering that a contact was interested in creating a website for "green" products. You
cannot remember the contact's name or where you put the information. Was it in a note? A history? You can
search on the term "green".
EXAMPLE 2: You want to find all contacts you do not have email addresses for and create a list so that you can
get the information.
Search using a search term
1. In the Search text box in the global toolbar, type your search term or terms. Click Go.
If Search finds items, results appear in columns showing the type (Contact, note, etc.), name, field name
and content, and last edited date. If available, use the scroll bar to view all results.
If Search does not find anything, a message appears. Revise your search term, and search again.
2. (Optional) If Search returned too many results, and you need to narrow or limit the results, use the Show
Only and Last Edited filters located to the right of the results.
l
l

To limit the results by category, under Show Only, select one or more items.
To limit the results by date range, under Last Edited, select an item. By default, the All Dates filter is
selected.
Selecting or changing filters changes your search results. For example, selecting the “Groups” check
box will reset the search results to show only Group records.

3. You can do the following with the search results:
l

l

l

l

To view an item in the search results, such as a contact, click the Name hyperlink. The contact's Detail
view appears.
To create a lookup of the contact or company records found in your search results, click the Contacts
or Companies button under Create Lookup.
To change your search term and search again, clear the text in the Search box and type a new term.
Click Go.
To exit the Search pane, click any button on the Navbar.

Search for contact records missing an email address
1. On the Navbar, click Contacts.
2. On the Lookup menu, click E-mail Address.
3. In the Operator field, select Does Not contain Data.
To search for all contact records with email addresses, in the second drop-down list, select the operator Does
Contain Data.

4. Click OK.
The search results appear in the Contact List view. If only one contact record is found, the Contact Detail
view appears. You can print the list or export it to Excel.
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Share Information with Others
You have entered information into your database. Now, you want to share some of it with others, maybe someone
who does not have access to Act!. You can export information from several views, called list views, into Excel. You
can also print many items, such as views, lists, reports, address books, and calendars.
For more information about all the items you can print, see "Printing" in Help.
TIP: In most cases, the easiest way to print is to use the Quick Print tool on the toolbar. This prints the current view.
Export data to Excel
1. On the Navbar, click Contacts. Then, on the view toolbar, click List View.
2. (Optional) To make sure data appears in Excel in the order you want, on the view toolbar, click the
Customize Columns tool. Re-order the columns, and then click OK.
3. On the view toolbar, click the Export to Excel tool.
In Excel, the column headings and order are retained from the exported list. You may have to select the
worksheet from the taskbar.
Print an address book of all contacts
1. On the File menu, click Print.
2. In the Print dialog box:
a. From the Printout type list, select Address Book.
b. From the Paper type list, select an address book print template. To see what an address book
template looks like, select the Enable Preview check box.
c. To select the contacts to include in the address book and set options for formatting, whether or not to
include additional addresses, and other data, click the Options button.
i. From the Create printout for list, select All Contacts.
ii. Select or clear other options as needed. You can choose a font size, include other addresses for
each contact, and more.
iii. Click OK.
3. Click Print.
4. If another dialog box appears, you may need to select a printer. In most cases, the name of the printer that
your computer is connected to displays. Then, click Print or OK.
Print your calendar
1. On the Navbar, click Calendar.
2. Select the calendar view to print (Today, Daily, Weekly, Monthly).
3. On the view toolbar, click the Print tool.
4. In the Quick Print Options dialog box, keep the default options for page orientation and sizing or change
options. Click OK.
5. If a Print dialog box appears, select a printer or keep the default. Click OK.
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Important Notes:
For Act!: You must purchase one license of Act! per user. Scalability varies based on hardware, size, and usage
of your database. Review Act! system requirements at www.act.com/systreq. Visit the Marketplace or contact your
add-on product provider to determine compatibility for your add-on products.
Version: UA11_2019
© 2019 Swiftpage ACT! LLC. All Rights Reserved.
Swiftpage, Act!, and the Swiftpage product and service names mentioned herein are registered trademarks or
trademarks of Swiftpage ACT! LLC, or its affiliated entities.
All other trademarks are the property of their respective owners.
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